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Promulgation Statement 
The Georgia Emergency Management and Homeland Security Agency (GEMA/HS) 
Plans Standardization and Maintenance Policy is the base document for the 
development, formatting, evaluation, maintenance, and revision of all plans, policies, 
procedures, and other documents created by GEMA/HS.   
This policy has been developed in accordance with guidance standards set forth in the 
Emergency Management Accreditation Program and the State’s Emergency 
Management Program. 
This policy, and its supporting annexes, has been approved for implementation by: 
 
 
 
 
_______________________ _7/15/2025___________ 
Josh Lamb Date 
Director 
Georgia Emergency Management and  
   Homeland Security Agency  
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1.0 Introduction  

1.1 Purpose 
The purpose of the Plans Standardization and Maintenance Policy is to ensure there is 
a methodology to promote commonality, integration, maintenance and critical evaluation 
among the diverse catalog of emergency plans, policies, and procedures maintained by 
the Georgia Emergency Management and Homeland Security Agency (GEMA/HS), 
herein referred to as the Agency. Standardization of plans saves time, enhances 
effective communication, reinforces the planning process, encourages comprehensive 
planning, and makes “plan” navigation easier. Once emergency plans, policies, and 
procedures are implemented, it is critical that every plan be maintained to ensure they 
remain relevant, practicable and current. 

1.2 Scope 
This Plans Standardization and Maintenance Policy applies to all sections and 
programs in GEMA/HS. 

1.3 Objectives 
The goals and objectives of the Plans Standardization and Maintenance Policy are: 
Goal: Build commonality, standardization, integration and maintenance among the 
diverse catalog of emergency plans, policies, and procedures.  
Objectives: 
1. Promote an organized and deliberate planning process. 
2. Ensure the involvement of stakeholders in plan development. 
3. Ensure the widest use of the Plan Template. 
4. Ensure the upkeep of the internal and external plans listed in the Plans Library. 
5. Ensure the periodic evaluation, review and revision of all emergency plans, policies 
and procedures using the Plans Schedule. 

2.0 Authority  
The authority for the Georgia Emergency Operations Plan is based on Official Code of 
Georgia, Title 38, Section 3, and Articles 1 through 3, known as the Georgia 
Emergency Management Act of 1981, and is compliant with the National Incident 
Management System and supports the National Response Framework. 
O.C.G.A. § 38-3-1, et.seq. establishes legal authority for development and maintenance 
of Georgia's Emergency Management Program and organization, and defines the 
emergency powers, authorities, and responsibilities of the Governor and the Director of 
the Georgia Emergency Management and Homeland Security Agency. Moreover, the 
State’s emergency services and disaster laws require State and local governments 
develop and maintain current Emergency Operations Plans in preparation for a variety 
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of natural and human caused hazards. Executive Orders by the Governor supplement 
the laws and establish specific planning initiatives and requirements.  

3.0 Situation and Assumptions  

3.1 Situation Overview  
This section is respectfully omitted; however, for the purposes of this policy it is 
included in the format. 

3.2 Planning Assumptions  
This section is respectfully omitted; however, for the purposes of this policy it is 
included in the format. 

4.0 Functional Roles and Responsibilities  

4.1 Functional Roles   
The Director of GEMA/HS is charged with the reduction of the loss of life and property 
for natural, technological, and human-caused incidents. GEMA/HS utilizes an all 
hazards approach to preparedness, response, recovery, and mitigation while providing 
leadership, assistance, and support to local, regional, State, and tribal entities. 

4.2 Assignment of Responsibilities 
Director of GEMA/HS shall approve any additions, changes or modifications to 
emergency plans in addition to the maintenance, approval, modification to and 
dissemination of this policy as required and will hold periodic staff meetings to ensure 
communication and information flow between management and staff.  
Senior Staff and Section Managers are responsible for ensuring steps outlined in this 
policy are continuously monitored for consistency as well as communicating and 
maintaining this oversight to establish an environment that emphasizes the importance 
of these planning processes throughout the Agency. 
Senior Staff and Section Managers will  
1. Enforce this Policy and all relevant planning processes.  
2. Ensure Branch specific plans, policies, and procedures are up-to-date in accordance 
with this Policy. 
3. Supervise employees to ensure accountability for their plan, policy, and procedure 
development and maintenance responsibilities. 
GEMA/HS Staff members are responsible for developing, revising, updating, and 
reviewing plans, policies, and procedures which include but are not limited to strategic, 
operational, and tactical plans.  Although many planning efforts overlap dependent upon 
individual topics, the fundamental premise of segregated duties amongst planning staff 
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is to ensure that an individual or small group of individuals should not be able to initiate, 
approve, undertake, and review the same planning action.  
This Agency will observe clear lines of authority where roles and responsibilities of each 
employee in the Agency are defined. All GEMA/HS staff members will be aware of 
designated responsibilities within the Agency. There is an expectation that all staff will 
follow the processes set forth in this document.   
The Deputy Director – Emergency Management (EM) is responsible for overseeing 
and facilitating the process for all components of this policy, as well as providing 
oversight for all planning functions of GEMA/HS under the leadership of the Agency’s 
Director. The EM Planning Manager is responsible for the implementation of the 
GEMA/HS Review & Revision process and has the authority to make adjustments to the 
GEMA/HS Plans Schedule to ensure the workload is reasonable and achievable. The 
EM Planning Manager also has the authority to “Defer” the revision or update of any 
plan in the GEMA/HS Plans Library based on the operational necessity of the Agency. 

5.0 Logistics Support and Resources Requirements  

5.1 Logistics Support  
This section is respectfully omitted; however, for the purposes of this policy it is 
included in the format. 

5.2 Resources Requirements  
This section is respectfully omitted; however, for the purposes of this policy it is 
included in the format. 

6.0 Concept of the Operation 
The Plans Standardization and Maintenance Policy has four main components:  
Policy: The Policy articulates the entire process of plan development, evaluation and 
maintenance. The life of a plan generally begins with an identified need, engagement of 
stakeholders, research, drafting of a plan, approval, promulgation, maintenance and 
ending with the potential rescindment of the document.   
Plans Schedule: The Plans Schedule lists all approved and promulgated plans 
currently published. The Plans Schedule is the long-term work plan for ensuring all 
internal plans, policies and procedures are properly evaluated, reviewed and revised. 
Plans Library: The Plans Library lists all state-level plans maintained by GEMA/HS. 
Plans Format Template: The Plans Format Template is the agency standard and 
approved format for all plans. 
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6.1 Execution  

6.1.1 Policy  
The Policy outlines the three Categories of Plans, policies, and procedures: Strategic, 
Operational, and Tactical. Details about each plan type follow: 
Strategic Plans describe how an entity intends to organize, prioritize and allocate 
planning responsibilities. These plans are driven by initiatives established by GEMA/HS 
executive leadership and senior State officials. Examples of strategic plans are Multi-
year Strategic Plan, the Continuity of Government (COG) Plan, and Training and 
Exercise Plan (TEP). 
Operational Plans provide a description of roles and responsibilities that an entity’s 
departments and agencies are assigned during an emergency. These plans focus on 
coordinating and integrating the activities of several response and support 
organizations. Operational plans are generally complex and comprehensive, and focus 
more on the broader physical, spatial, and time-related dimensions of an operation. 
Operational plans also provide the framework for tactical plans. An example of an 
operational plan is the Georgia Emergency Operations Plan (GEOP). 
Tactical Plans focus on managing personnel, equipment, and resources that play a 
direct role in an incident response. Pre-incident tactical planning, based upon existing 
operational plans, provides the opportunity to pre-identify personnel, equipment, 
exercise, and training requirements. Examples of tactical plans include Continuity of 
Operations Plan (COOP), Incident Annexes, and Logistics Plans. 
This Policy also outlines the process for new plan development. A new plan is 
developed to achieve a desired planning goal or existing gap. The planning process 
identifies goals and objectives by establishing a development process to complete a 
fully functional plan.   New Plan Development consists of seven steps: 
1. Engage Stakeholders; 
2. Research and Draft Plan; 
3. Comment and Review Period; 
4. Approval and Distribution of Plan; 
5. Exercise the Plan; 
6. Identify Corrective Actions and Improve Plan; and 
7. Publish Lessons Learned and After-Action Reports. 
This seven step process is outlined in detail below: 
Step 1: Engage Stakeholders 
The planning process may involve participation from multiple stakeholders depending 
on the plan type. The planning lead shall identify, reaffirm or include additional 
stakeholders at the beginning and throughout the planning process and will maintain 
communication and encourage stakeholder participation throughout the plan 
development process. Stakeholder roles will be established following initial 
correspondence, as applicable. GEMA/HS staff is responsible for collaborating and 
engaging internal and external stakeholders throughout the planning process. External 
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stakeholders may include, but are not limited to, representatives from local, state, 
federal, Non-Government Organizations, or private organizations. 
Step 2: Research and Draft Plan 
The initial development process includes researching and drafting of a plan with input 
from stakeholders. To adhere to the Agency’s recommended plan format, refer to the 
Plan Standardization Template in Annex A. 
Step 3: Comment and Review Period 
Following the completion of a draft plan, a comment deadline for stakeholders will be 
established at the time of distribution and all comments will be returned to the planning 
lead in a pre-determined format. Stakeholders will be requested to review appropriate 
sections of the draft as outlined in the distribution correspondence. Stakeholder reviews 
will be evaluated on the following six categories: 
Category 1: A plan may be considered acceptable if it meets the goals and objectives 
in accordance with relevant guidance, statutes and regulations. 
Category 2: A plan may be considered adequate if the goals and objectives sufficiently 
identify and address critical tasks as stated in relevant guidance, statutes and 
regulations.  
Category 3: A plan may be considered complete if actions are identified to support a 
desired outcome of goals and objectives. 
Category 4: A plan may be considered compliant if developed using the necessary 
guidance, statutes and regulations.  
Category 5: A plan may be considered feasible if the entity can accomplish the goals 
and objectives by utilizing all available resources. 
Category 6: A plan may be considered functional if the document can be executed. 
Once all stakeholder comments are received, the planning lead will review and 
incorporate relevant revisions. Upon completion of the revised draft, the Planning Lead 
will submit the document to the EM Planning Manager to insure it meets the Agency’s 
formatting standards. The EM Planning Manager will return the document to the 
Planning Lead within ten business days and any outstanding comments will be 
incorporated at that time. 
Step 4: Approval and Plan Distribution  
Approval 
If the plan requires the GEMA/HS Director’s signature, then the Planning Lead shall 
ensure that the plan approval and adoption processes are completed in compliance with 
relevant mandates, statutes and regulations.  
Plan Distribution 
Once the Director of GEMA/HS has given final approval of the plan, the Planning Lead 
should arrange to distribute the plan and maintain a record of the stakeholders that 
received a copy of the plan. A record of the plan distribution, to include the list of 
stakeholders and a date stamped e-mail “distributing” the plan will be maintained in the 
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appropriate file.  All plans will be in .pdf file format for e-mail distribution. The Planning 
Lead will return the document to the EM Planning Manager for submission into the 
Plans Library. 
Step 5: Exercise the Plan 
As applicable, the Agency’s Training and Exercise Section shall exercise the plan to 
ensure capabilities are aligning with existing laws, statutory obligations, and resource 
availabilities as outlined in the plan. Exercising the plan in advance of an incident is a 
method to identify inefficiencies and evaluate preparedness. All exercises should 
include an After Action Review (AAR) to help detect weaknesses in the plan which will 
be remedied in future updates.  
Step 6: Identify Corrective Actions and Improve Plan 
A corrective action process allows GEMA/HS staff to identify, address, and correct 
problems within a plan. This process may involve the revision of planning assumptions, 
operational concepts, organizational tasks, or instruction based on information from 
areas where deficiencies may exist such as exercises, AARs, lessons learned, and 
audits. Any actions identified should be discussed during the next plan review and 
update process, as necessary. 
Included in this Step is the process for making comments and/or suggestions outside 
the formal solicitation for comments. Any person may submit comments outside the 
scheduled Comment and Review Period using the following guidelines: 
1. Use only one Plan Change Request form for each proposed change. 
2. Include EXACT proposed language. Any Plan Change Request form without EXACT 
language included will not be accepted. 
3. Routine Plan Change Requests will be completed during the scheduled Comment 
and Review Period. 
4. Immediate Plan Change Requests will be completed within 15 working days from 
receipt of the Plan Change Request. 
5. The GEMA/HS EM Planning Manager reserves the authority to only include valid 
Plan Change Requests proposals. 
6. All completed changes will be distributed by e-mail. 
Note: GEMA/HS Plan Change Request Form can be found in Annex B. 
Step 7: Publish Lessons Learned and After-Action Reports 
The EM Planning Manager, in cooperation with the other Section Managers, will ensure 
all pertinent deficiencies identified in the corrective action process are incorporated into 
the Review & Revision process. 

6.1.2 Plans Schedule  
The Plans Schedule outlines the Update and Revision guidelines. A plan is updated or 
revised to reflect changes in either planning goals or objectives, or as mandated by 
guidance or statutes and regulations.  
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Reasons for a Plan Revision. Before starting the plan update process, stakeholders 
must be engaged and the planning lead shall provide participants with a copy of the 
plan to be updated. Reasons to review and update a plan may include, but are not 
limited to: 

• An existing plan maintenance cycle; 
• A major incident; 
• The impacts of an incident based on an exercise or AAR; 
• Change in operational resources or elected officials; 
• Change in hazards or threats; 
• Updated planning standards or guidance; 
• New and/or amended laws; and 
• Grammatical errors or programmatic changes. 

Revision of an Existing Plan. To revise an existing Plan, Policy Manual, and/or 
Standard Operating Guide/Procedure, the Planning Lead shall determine the level of 
revision required to modify the plan (Partial or Full). A plan may be evaluated and 
reviewed to determine if the planning goals or objectives sufficiently meet the mandated 
guidance, statutes and regulations. The Planning Lead shall review the plan thoroughly 
and assess the format and contents for conformity to applicable requirements. The 
GEMA/HS review and revision process is detailed below: 
1. Review:  
All Plans, Policy Manuals, and/or Standard Operating Guides/Procedures are required 
to be reviewed within 24-months of the Promulgation date. Any plan “reviewed” will 
have two potential findings;  

a. No Action Required or  
b. Update Required. 

If the Plan, Policy Manual, and/or Standard Operating Guide/Procedure has a “No 
Action Required” finding, then it will be given an automatic 24-month extension. 
If the Plan, Policy Manual, and/or Standard Operating Guide/Procedure has an “Update 
Required” finding, then it will be scheduled for an (Partial or Full) update.  
Partial Updates are generally categorized as administrative updates or corrections and 
do not substantially change the original intent and purpose of the plan. Partial Updates 
can be annotated on the Record of Change table of the plan. Those changes will be 
distributed to those listed on the Distribution List table. 
2. Full Update: 
All Plans, Policy Manuals, and/or Standard Operating Guides/Procedures are required 
to be fully updated within 48-months of the Promulgation date. Based on the Review, 
the original Planning Lead or responsible Section Manager will determine the level or 
effort of the plan Update. 
Full Updates require that the formal planning process be used; stakeholder 
engagement, content review and comment. The entire plan will require a new signature 
and distribution to those listed on the Distribution List table.  Note:  Policy Manuals 
and/or Standard Operating Guides/Procedures will not require signature. 
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All Updates of existing plans will have the following statement inserted in the Record of 
Changes table (Description of Change column); “This version supersedes Full Name 
and Date of Plan, which is rescinded.” 
3. Defer:  
Any plan (other than the State Hazard Mitigation Plan) can be deferred from an Update 
only. 
In consultation with the plan’s responsible GEMA/HS Deputy Director, the EM Planning 
Manager may recommend that plan(s) Updates (Partial or Full) be deferred. 
Deferment would most likely be recommended/approved based on emergencies, 
disasters, or ongoing activations that require the full attention of GEMA/HS which 
negates the scheduled plan Update. 
No plan may be deferred from an Update for more than one 12-month period at a time.  
4. Rescind:  
Any plan that has outlived its usefulness or that has become obsolete may be 
Rescinded. In consultation with the Director of GEMA/HS, the EM Planning Manager or 
responsible Planning Lead may recommend that applicable plan(s) be Rescinded. 
Any plan scheduled for Rescindment will require a formal letter, signed by the Director 
of GEMA/HS, to all plan stakeholders stating that the plan is rescinded. 
Comment and Review Period. During the plan update and revision process, the 
planning lead may coordinate with stakeholders, as applicable, to identify areas 
requiring improvement. Stakeholders involved in this process may be requested to 
review the updated or revised plan to ensure it continues to meet all applicable 
components of the planning process. This process will also determine the plan’s 
progress in the six categories as outlined in the Comment and Review Period section of 
New Plan Development. Upon conclusion of the comment and review period, follow and 
complete the remaining tasks, as applicable, in the New Plan Development section.  
Review of an External Plan. An external plan review is conducted to evaluate a plan 
developed by an outside entity. The evaluation should include comprehensive review of 
the goals and objectives as they relate to the plan-specific metrics or requirements.  
GEMA/HS staff may be tasked with reviewing a plan not authored by the Agency. 
Different levels of review may be necessary depending on the type of plan. The 
planning lead may be required to make recommendations for improvement, and provide 
comments back to the original authoring entity. 

6.1.3 Plans Library  
The Plans Library lists all state documents maintained by GEMA/HS. The Plans Library 
consists of both digital and paper copies. All paper copies are stored in the EM Planning 
Section. 
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6.1.4 Plans Format Template  
The Plans Format Template is the agency standard and approved format for all plans.  
A successful plan format incorporates basic planning components that assist users in 
navigating and referencing the document. Plans Format Template provides a plan 
format that incorporates these components and is designed to enhance fluidity and 
readability of the plan in development. This template shall be incorporated into all new 
planning documents. The sample templates are listed in Annex A, Plan Standardization 
Template. 

7.0 Plan Maintenance, Evaluation and Revisions 

7.1 Plan Maintenance 
GEMA/HS is the responsible agency for publishing the Standardization and 
Maintenance Policy. The Director of GEMA/HS in conjunction with Section Managers 
will oversee the update and maintenance of this policy as required. Appropriate officials 
in State agencies should recommend changes at any time and provide information 
periodically as to changes of personnel and available resources.  
Each Plan, Policy Manual, and/or Standard Operating Guide/Procedure will include a 
method and schedule for evaluation, maintenance, and revision in order to ensure 
routine review, evaluation and update over the lifecycle of each document. 

7.2 Training and Exercise 
The State’s EM Training and Exercise Program aims to test, assess, and improve the 
State’s preparedness and resiliency. By assessing preparedness against a set of 
common preparedness priorities, the Training and Exercise Program improves 
preparedness and resiliency and affects policy, priorities and fiscal decisions. GEMA/HS 
will train to and exercise elements of this policy alone or as part of a larger exercise. As 
part of the planning review and revision process, all corrective actions from training and 
exercise events will be collected and analyzed. This corrective action process allows 
GEMA/HS staff to identify, address, and correct problems within a plan. This process 
may involve the revision of planning assumptions, operational concepts, organizational 
tasks, or instruction based on information from areas where deficiencies may exist such 
as exercises, AARs, lessons learned, and audits. 

8.0 Administration  
GEMA/HS will be responsible for the promulgation, distribution and periodic update of 
this policy. 

8.1 Emergency Management Program Elements  
The Standardization and Maintenance Policy adheres to the 2016 Emergency 
Management Standards outlined by the Emergency Management Accreditation 
Program (EMAP). Specifically, that the “Emergency Management Program has a 
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method and schedule for evaluation, maintenance, revision, of the plan and procedures 
identified in the following standards:” 

 3.1.1 Program Administration and Evaluation; 
 3.4.3 Administration and Finance; 
 4.1.3 Hazard Identification, Risk Assessment and Consequence Analysis; 
 4.2.5 Hazard Mitigation; 
 4.3.3 Prevention; 
 4.4.2 Operational Planning and Procedures; 
 4.4.9 Operational Planning and Procedures; 
 4.5.7 Incident Management; 
 4.6.6 Resource Management, Mutual Aid and Logistics; 
 4.7.6 Communications and Warning; 
 4.8.3 Facilities; 
 4.9.1 Training; and 
 4.11.5 Emergency Public Information and Education. 

8.1 Acronyms 

  

Abbreviation 
 

Term 
 AAR After Action Review 

COG Continuity of Government Plan 
 COOP 

 
Continuity of Operations Plan 
 EM Emergency Management 

EMAP Emergency Management Accreditation Program 
GEMA/HS Georgia Emergency Management and Homeland Security Agency  
GEOP  Georgia Emergency Operations Plan  
TEP Training and Exercise Plan 
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Annex A Standardization Template  

A.1 Cover Page  
The cover page should be consistent with the format utilized for the title page of this 
document and should contain the name of the plan and the year of the plan. The plan title 
shall be centered on the page and right justified, written in Arial font, no greater than 26pt, 
and the date shall be written in Arial font, 60pt. The remainder of the plan shall be written 
in Arial font, 12pt, right justified text. 
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A.2 Table of Contents  
The Table of Contents outlines the plan’s general format and includes key sections, tables 
and figures, appendices and annexes. The plan’s Table of Contents should not be 
populated manually, but rather using the ‘Automatic Table 2’ option under References in 
Microsoft Word. 
*Do not include a section if it is not applicable to the plan. 
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A.3 Promulgation Statement, Approval and Implementation and Executive 
Summary 
Place the Promulgation Statement, Approval and Implementation and Executive 
Summary each on a separate page by ensuring there is a page break at the end of 
each. 
The Promulgation Statement page may not be used in every plan.  Promulgation is the 
process that officially announces/declares a plan. It gives the plan official status and 
gives both the authority and the responsibility to organizations to perform their tasks.  
The Promulgation Statement may be replaced with a local ordinance, if applicable, 
which defines the requirements for the document. 
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A.4 Record of Change  
When changes are made to the plan outside the official cycle of plan review, 
coordination, and update, planners should track and record the changes using a record 
of changes table. The record of changes will contain, at a minimum, a change number, 
the date of the change, the name of the person who made the change, and a 
description of the change. 

 

A.5 Record of Distribution 
The record of distribution, usually in table format, indicates the title and the name of the 
person receiving the plan, the agency to which the receiver belongs, the date of 
delivery, the method of delivery, and the number of copies delivered. The record of 
distribution can be used to verify that tasked individuals and organizations have 
acknowledged their receipt, review, and/or acceptance of the plan. 
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A.6 Introduction  

Section 1.0 Introduction contains a minimum of two subsections, Purpose and Scope or 
Goals and Objectives. GEMA/HS typically uses the following three subsections: 

 

A.7 Authority 
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A.8 Situation and Planning Assumptions 

The Situation Overview section is not required in subordinate plans if it is covered in the 
referenced base plan and referenced.  If used, it will have three subsections: 

1. Characteristics, 
2. Hazard Profile and 
3. Vulnerability Assessment. 
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A.9 Functional Roles and Responsibilities 

 

 

A.10 Logistics Support and Resources Requirements  
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A.11 Concept of the Operation  

 

A.12 Plan Maintenance, Evaluation and Revisions 

 

A.13 Administration  
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Annex B Plan Change Request Form  
 
Plan Name GEMA/HS Plans Standardization and Maintenance Policy  
Plan Date May 2025 
Page #   
Section # / Paragraph #   
Current Wording   

Recommended 
Change 

  

Reason for Change   

Name of 
Recommender 

  

Agency   

Phone # (         )         - 

Email Address   

Date Submitted  

   To Be Filled Out By GEMA/HS Emergency Management Planning Staff    

Date Received  

Received By  

Assigned To   

Date of Assignment  

Date Processed  

Action Taken?  

Date Plan Updated  

 

• Please complete this form and submit to the GEMA/HS Emergency Management 
Planning Section for processing. 

• One form is required for each recommended change to the plan.  
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Annex C Template Formatting  

The new planning template is designed to meet Federal Emergency Management 
Agency standards, and the Emergency Management Accreditation Program standards. 
This template also meets the Americans with Disabilities Act requirements and provides 
instruction on properly converting a word document to a portable document format 
(PDF) to make it accessible under the ADA. 

C.1 How to use this template 

It is recommended to use the autosave function to ensure that all changes are captured 
in the event a computer error occurs while editing. 

Below is a list of all required sections for any plan that is developed.  This is based off 
CPG 101 guidance, the GEOP and the requirements set forth by the Emergency 
Management Accreditation Program (EMAP).  Not all sections and subsections are 
required in every plan.  The saved plan has a  

1. Table of Contents  
2. Promulgation Statement 
3. Approval and Implementation 
4. Executive Summary 
5. Record of Change  
6. Record of Distribution  
7. Introduction Section  
8. Concept of Operations section 
9. Organization and Assignment of Responsibilities section  
10. Plan Development and Maintenance section and  
11. Authorities and References section.  

C.2 Save the Plan Template  

1. Open the plan template. 
2. Under the “File” tab select “Save As” and save your Plan using the name of the plan 
to a location of your choosing. For example, the Georgia Emergency Operations Plan 
would be saved as “GEOP Plan” to my desk top.  
3. Once you saved your Plan close the Plan template and open the saved Plan. 

C.3 Create the Cover page 

1. Use the current cover page approved by GEMA/HS External Affairs and format in 
accordance with Appendix A of this document. 
2. Ensure there is a Section Break immediately following the Date. 
3. On the second page, type “This page intentionally left blank” centered at the top, 
middle and bottom of the page using a 24 font size.  
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C.4 Table of Contents  

The Table of Contents is updated by clicking on the TOC and selecting update table, 
then update entire table. 

 

C.5 Formatting 

C.5.1 Page Numbers 

1. Cover page will not contain a page number. 
2. Numbering will begin on the second page with lower case roman numerals. 
3. Numbering will change between the Table of Distribution and Section 1.0. 

a. Insert a section break after the Table of Distribution. 
b. Double click into the Footer area. This will grey out the main body and open the 
Header/Footer sections.  Cover page should have Different First Page Checked.  
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c. Move to the Footer for the blank page immediately following the Cover Page. 
d. Under the Insert Tab on the ribbon, click Page Number -> Bottom of Page -> Plain 
Number 3. 

 

e. Right click on the page number. Select Format Page Numbers. 

 

  



24 
 

 

f. In Number Format, select the lower-case roman numerals. Under Page 
Numbering, Select Start at.  Change the value to “ii” then click on OK. 

 

g. Move to the Footer for the first page of the next section. This will be the page 
immediately following the Table of Distribution and will have 1.0 Introduction at the 
top. 
h. Right click the page number and select Format Page Numbers again. 
i. In Number Format, select the Arabic numbers. Under Page Numbering, Select 
Start at.  Change the value to “1” then click on OK. 
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C.5.2 Headings 

1. In the ribbon, click on Styles->Right click on Heading 1 -> click on Modify. 

 

2. Check the highlighted boxes: 
a. Name = Heading 1. 
b. Style for following Paragraph = Normal. 
c. Font = Arial, 14pt, Bold. 
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3. Click on the Font Color = Dark Blue Text 2 (see location in the picture below). 

 

4. On the bottom, click Format -> Click Paragraph. 

 

  



27 
 

5. Check the highlighted boxes: 
a. Indentation Left = 0. 
b. Spacing Before = 24. 
c. Spacing After = 0. 
d. Line Spacing = Single. 

 

6. On the bottom, click Format -> click Border 
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7. Check the highlighted boxes: 
a. Line Style = solid, narrow line (first choice). 
b. Click ONLY the location box that indicated a Bottom Border 
c. Color = Dark Blue Text 2 (Same as the font color). 
d. Width = 2 ¼ pt. 
e. Apply for = Paragraph. 

 

8. At the bottom of the Modify Style tab, ensure the boxes for Automatically Update and 
New Document based on this Template are checked. 
9. Click OK 
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10. In the ribbon, click on Styles->Right click on Heading 2 -> click on Modify. 
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11. Repeat the procedure from Heading 1 with the following formats: 
a. Name = Heading 2. 
b. Style for following Paragraph = Normal. 
c. Font = Arial, 13pt, Bold. 
d. Font Color = Dark Blue Text 2. 
e. Indentation Left = 0. 
f. Spacing Before = 10. 
g. Spacing After = 0. 
h. Line Spacing = Single. 
i. Border = None. 
j. Ensure the boxes for Automatically Update and New Document based on this 
Template are checked. 
k. Click OK 
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12. In the ribbon, click on Styles->Right click on Heading 3 -> click on Modify. 
13. Repeat the procedure from Heading 1 with the following formats: 

a. Name = Heading 3. 
b. Style for following Paragraph = Normal. 
c. Font = Arial, 12pt, Bold. 
d. Font Color = Dark Blue Text 2. 
e. Indentation Left = 0. 
f. Spacing Before = 10. 
g. Spacing After = 0. 
h. Line Spacing = Single. 
i. Border = None. 
j. Ensure the boxes for Automatically Update and New Document based on this 
Template are checked. 
k. Click OK 
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14. In the ribbon, click on Styles->Right click on Normal -> click on Modify. 
15. Repeat the procedure from Heading 1 with the following formats: 

a. Name = Normal. 
b. Style for following Paragraph = Normal. 
c. Font = Arial, 12pt. 
d. Font Color = Automatic (Black). 
e. Indentation Left = 0. 
f. Spacing Before = 6. 
g. Spacing After = 6. 
h. Line Spacing = Single. 
i. Border = None. 
j. Ensure the boxes for Automatically Update and New Document based on this 
Template are checked. 
k. Click OK 

C.5.3 Numbering Format for Headings Only 

1. To create the proper numbering format for the headings, follow this procedure. 
2. In the ribbon, click on Paragraph->click the dropdown arrow for Multilevel Lists -> 
click on Define New Multilevel List. 
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3. Click on Level 1 and check the highlighted boxes: 
a. Link level to Style = Heading 1. 
b. Enter Formatting for Number = You must add .0 after the highlighted number. 
c. Number style for this level = Arabic numbers (1, 2, 3) 

1)  
d. Start at = 1. 
e. Check Legal Style Numbering 
f. Number alignment = left. 
g. Aligned at = 0. 
h. Text Indent at = 0. 
i. Follow number with = Space 
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4. Click on Level 2 and check the highlighted boxes: 
a. Link level to Style = Heading 2. 
b. Enter Formatting for Number = You should not need to change this.  Both 
numbers should automatically be highlighted with a period (.) in between. 
c. Start at = 1. 
d. Check Restart list after (the box below should automatically read Level 1). 
e. Check Legal Style Numbering 
f. Number alignment = left. 
g. Aligned at = 0. 
h. Text Indent at = 0. 
i. Follow number with = Space 
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5. Click on Level 3 and check the highlighted boxes: 
a. Link level to Style = Heading 3. 
b. Enter Formatting for Number = You should not need to change this.  All three 
numbers should automatically be highlighted with a period (.) in between. 
c. Number style for this level = Arabic numbers (1, 2, 3) 

1)  
d. Start at = 1. 
e. Check Restart list after (the box below should automatically read Level 2). 
f. Check Legal Style Numbering 
g. Number alignment = left. 
h. Aligned at = 0. 
i. Text Indent at = 0. 
j. Follow number with = Space 
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C.6 Numbered or Bulleted Lists 
• Do no use bullets or numbered lists unless there is more than one item. 
• Bullets should only be used if there is only one level of indentation. 
• Numbered Lists should not exceed 3 levels, whenever possible. 

C.6.1 Bulleted Lists 

1. In the ribbon, click on the Bullet List icon. 
2. Click on the solid black circle option. 

 

3. Check the Margin Indicators and adjust as instructed below (there is not an option to 
set these automatically, it must be done manually). 
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4. Click and hold the top margin and move it to the .25 inch position (indicated by the 
second hashmark from the left). 

 

5. Click and hold the bottom margin and move it to the .25 inch position (ensure to grab 
ONLY the upward pointed block.  If you grab the square block below, it will move both 
indicators). 
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6. Clear any tab markers and place a tab stop at the .5 inch position. 

 

C.6.2 Numbered Lists 

To create the proper numbering format for the headings, follow this procedure. 

1. In the ribbon, click on Paragraph->click the dropdown arrow for Multilevel Lists -> 
click on Define New Multilevel List. 
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2. Click on Level 1 and check the highlighted boxes: 
a. Link level to Style = (no style). 
b. Enter Formatting for Number = ensure the highlighted number is followed by a 
period (.). 
c. Number style for this level = Arabic numbers (1, 2, 3). 
d. Start at = 1. 
e. Uncheck Legal Style Numbering. 
f. Number alignment = left. 
g. Aligned at = 0. 
h. Text Indent at = 0. 
i. Follow number with = Space. 
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3. Click on Level 2 and check the highlighted boxes: 
a. Link level to Style = (no style). 
b. Enter Formatting for Number = ensure the highlighted number is followed by a 
period (.). 
c. Number style for this level = lower case letters (a, b, c). 
d. Start at = a. 
e. Check Restart list after (the box below should automatically read Level 1). 
f. Uncheck Legal Style Numbering. 
g. Number alignment = left. 
h. Aligned at = .25. 
i. Text Indent at = .25. 
j. Follow number with = Space. 
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4. Click on Level 3 and check the highlighted boxes: 
a. Link level to Style = (no style). 
b. Enter Formatting for Number = ensure the highlighted number is in parentheses 
(). 
c. Number style for this level = Arabic numbers (1, 2, 3). 
d. Start at = 1. 
e. Check Restart list after (the box below should automatically read Level 2). 
f. Uncheck Legal Style Numbering. 
g. Number alignment = left. 
h. Aligned at = . 5. 
i. Text Indent at = . 5. 
j. Follow number with = Space. 
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5. Click on Level 3 and check the highlighted boxes: 
a. Link level to Style = Heading 3. 
b. Enter Formatting for Number = ensure the highlighted number is in parentheses 
(). 
c. Number style for this level = lower case letters (a, b, c). 
d. Start at = a. 
e. Check Restart list after (the box below should automatically read Level 3). 
f. Uncheck Legal Style Numbering. 
g. Number alignment = left. 
h. Aligned at = .75. 
i. Text Indent at = .75. 
j. Follow number with = Space 
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C.7 Annex Formatting 

C.7.1 Annex Headings 
1. In the ribbon, click on Styles-> click on Create a Style. 
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2. In the Create New Style from Formatting box: 
a. Change the Name to “Annex Heading 1”. 
b. Click Modify. 
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3. Check the highlighted boxes: 
a. Name = Annex Heading 1. 
b. Style type = Linked (paragraph and character). 
c. Style based on = Heading 1  

1) That allows this heading to duplicate all formatting you have already 
developed for Heading 1 previously. 

d. Style for following Paragraph = Normal. 
e. Verify that all settings for Heading 1 are correct. 

4. Ensure the following are checked at the bottom: 
a. Add to the Styles gallery. 
b. Automatically Update. 
c. New document based on this template. 
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5. In the ribbon, click on Styles-> click on Create a Style. 
6. In the Create New Style from Formatting box: 

a. Change the Name to “Annex Heading 2”. 
b. Click Modify. 

7.  Check the highlighted boxes: 
a. Name = Annex Heading 2. 
b. Style type = Linked (paragraph and character). 
c. Style based on = Heading 2  
d. Style for following Paragraph = Normal. 
e. Verify that all settings for Heading 2 are correct. 

8. Ensure the following are checked at the bottom: 
a. Add to the Styles gallery. 
b. Automatically Update. 
c. New document based on this template. 
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9. In the ribbon, click on Styles-> click on Create a Style. 
10. In the Create New Style from Formatting box: 

a. Change the Name to “Annex Heading 3”. 
b. Click Modify. 

11.  Check the highlighted boxes: 
a. Name = Annex Heading 3. 
b. Style type = Linked (paragraph and character). 
c. Style based on = Heading 3  
d. Style for following Paragraph = Normal. 
e. Verify that all settings for Heading 3 are correct. 

12. Ensure the following are checked at the bottom: 
a. Add to the Styles gallery. 
b. Automatically Update. 
c. New document based on this template. 
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C.7.2 Annex Numbering 

1. In the ribbon, click on Paragraph->click the dropdown arrow for Multilevel Lists -> 
click on Define New Multilevel List. 
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2. Click on Level 1 and check the highlighted boxes: 
a. Link level to style = Annex Heading 1. 
b. Enter Formatting for Number =  

1) Place your cursor before the highlighted number. 
2) Type “ANNEX “. 
3) Remove the period at the end. 

c. Number style for this level = Capital Letters (A, B, C). 
d. Start at = A. 
e. Uncheck Legal Style Numbering 
f. Number alignment = left. 
g. Aligned at = 0. 
h. Text Indent at = 0. 
i. Click Set for All Levels 

1) Bullet/Number position for first level = 0. 
2) Text position for first level = 0. 
3) Additional indent for each level = 0. 

j. Follow number with = Space 
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3. Click on Level 2 and check the highlighted boxes: 
a. Link level to Style = Annex Heading 2. 
b. Enter Formatting for Number = 

1) Place your cursor before the highlighted number. 
2) Click the dropdown for Include level number from: 
3) Click Level 1. 
4) Place a period between the two highlighted numbers. 
5) Remove the period at the end. 

c. Number style for this level = Arabic numbers (1, 2, 3) 
d. Start at = 1. 
e. Check “Restart list after:” and select Level 1 from the dropdown. 
f. Uncheck Legal Style Numbering 
g. Number alignment = left. 
h. Aligned at = 0. 
i. Text Indent at = 0. 
j. Follow number with = Space 

  



51 
 

4. Click on Level 3 and check the highlighted boxes: 
a. Link level to Style = Annex Heading 3. 
b. Enter Formatting for Number = 

1) Place your cursor before the highlighted number. 
2) Click the dropdown for Include level number from: 
3) Click Level 1. 
4) Place a period between the two highlighted numbers. 
5) Click the dropdown for Include level number from: 
6) Click Level 2. 
7) Place a period between the two highlighted numbers. 
8) Remove the period at the end. 

c. Number style for this level = Arabic numbers (1, 2, 3) 
d. Start at = 1. 
e. Check “Restart list after:” and select Level 2 from the dropdown. 
f. Uncheck Legal Style Numbering 
g. Number alignment = left. 
h. Aligned at = 0. 
i. Text Indent at = 0. 
j. Follow number with = Space 
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